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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Warranty and Repair Policy
The product is backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to 
extend the standard warranty period by one year increments. For more information, contact your 
regional sales manager.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com
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Introduction
This guide covers the installation, configuration, and operation of the Ultritouch-2-HR and 
Ultritouch-4. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Getting Started” provides an overview for creating a routing system with Ultritouch, and 

general information to keep in mind before installing and configuring your Ultritouch panel.
• “Hardware Overview” provides a basic introduction to the Ultritouch front and rear panels.
• “Physical Installation” provides instructions for the basic physical installation of the Ultritouch 

panel.
• “Cabling” provides instructions for connecting the Ultritouch to your network, and connecting the 

panel to a power source.
• “Configuring the Network Settings” provides instructions for configuring the network settings 

for the Ultritouch and navigating the touch-screen menus.
• “Basic Navigation” outlines the methods for accessing the Ultritouch menu system.
• “Communications with Devices” outlines how to enable the Ultritouch to communicate with 

devices in your routing system. 
• “File Management” outlines how to load a custom panel to Ultritouch and how to access the File 

Navigator interface, and manage your device files from the Ultritouch panel.
• “Managing Open Windows” outlines how to use this feature to quickly navigate, manage, and 

operate the devices connected to your Ultritouch.
• “Menu System Overview” summarizes the functions, menus, and parameters of the Ultritouch 

tabs and windows in DashBoard.
• “Technical Specifications” provides the specifications for the Ultritouch.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Ultritouch:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Ultritouch Quick Start Guide, Ross Part Number: 2201DR-902
• Ultritouch + Ultrix User Guide, Ross Part Number: 2201DR-904
• Walkabout Application Note, Ross Part Number: 2201DR-003

 The user documentation is available for download from our website.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Edit dialog, click Insert Above.
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User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the Ultrix User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 844-652-0645
• After Hours Emergency: (+1) 613-349-0006
• E-mail: solutions@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Getting Started
If you have questions pertaining to the operation of Ultritouch, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

 This guides uses the term Ultritouch to reference both the Ultritouch-2-HR and Ultritouch-4 
unless otherwise noted.

Overview
Ultritouch is a forward thinking, powerful system control panel from Ross Video. The panel is a 
rack-mountable touchscreen that combines traditional functionality while adapting work flows in a 
simple and intuitive interface. Due to its integration of DashBoard, Ultritouch controls a host of 
other Ross equipment in addition to third-party signal processing products.

Ultritouch supports a full version of DashBoard, which allows users to control and monitor things 
like openGear cards, create custom panels, etc. Not only do these new enhanced panel work flows 
encompass the broad range of hard panel operations, but they also provide a fully integrated touch 
UI that enables a user to quickly setup and use their panel.

The touchscreen also means that users can use the common DashBoard framework to build a 
completely custom set of panels with different button combination sizes, functions, and layouts, 
enhancing what is possible from a normal hardware button-based panel. Ultritouch combines 
common DashBoard touch controls, enhanced work flow specific product controls, and the ability 
to make completely user-definable panels for any application.

Features
The Ultritouch is used when you require advanced control functions from a single point. DashBoard 
client software runs on the Ultritouch panel to provide flexible connectivity. 

The following features are included:

• Touch-enabled DashBoard based remote control panel (RCP)
• Redundant power supply option
• Integrated speakers for monitoring
• HDMI and USB for external KVM operation
• DashBoard client software built on Ethernet and TCP/IP technology to allow remote access across 

LAN architectures
• Standard UI layout for openGear cards
• DashBoard tree and system management support
• Ability to store multiple panel types with intuitive navigation based on desired work flow
• Load customized user interfaces to control a wide range of Ross Video products and third-party 

systems
• Full control of DashBoard Connect devices with real-time control and alarming from a single 

Ultritouch panel
• Ability to have multiple control views active and available for selection on one touchscreen
• Easily upgrade the software and firmware on the Ultritouch panel in the field
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System Overview
The Ultritouch is used when you require advanced control functions from a single point.

Figure 1  Example of a Possible Routing System with Ultritouch-2-HR

Before You Begin
Before configuring and operating the Ultritouch, contact your IT department before connecting to 
your facility network to ensure that there are no conflicts. 

Installation and Setup Overview
The generalized work flow of installing and configuring your Ultritouch is:

1. Implement your routing system plan by installing the devices, configuring their settings, and 
setting up your databases and matrices.

2. Install and configure the Ultritouch.

3. Establish communications between Ultritouch and the devices in your routing system.

4. Install required license keys for additional device control.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Manual.
• planning and installing your routing system, refer to the user documentation that accompanied 

your devices.
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Ultritouch Operation Overview
Once configured, the Ultritouch provides central controller functionality for the routing system, 
including:

• the storage and implementation of routing system configurations, which collect a series of 
routing matrices into a system and provide a logical database view of the whole system

• switching the physical crosspoints of the routers according to the system configuration
• the control and system database interface for devices that control and/or display routing status 

(e.g. remote control panels, switchers, master control, automation systems, multi-viewers, and 
tally systems)

• virtual routing, matrix partitioning, and mapping
• label support for protocols supporting labels
• system control through DashBoard client software running on the Ultritouch panel
• connection and status logging 

Using Custom Panels on Ultritouch
Once your router connections are defined, and a database is established, you can start building a 
map of several different physical devices that become one virtual device. When a switch request is 
made for a virtual device, all the physical devices that are mapped to the virtual device are switched. 

Ultritouch enables you to map inputs and outputs from routers for control via any remote control 
panel. These parameters can be saved to a database, enabling you to change configurations easily 
and quickly, allowing devices to used in a number of different operating scenarios.
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Hardware Overview
This chapter presents information on the front and rear panels of the Ultritouch-2-HR and 
Ultritouch-4.

Front Panel Overview
Each Ultritouch front panel is a touchscreen display that enables you to access the features, 
settings, and monitoring options of the product. (Figure 2, Figure 3)

Figure 2  Ultritouch-2-HR — Front Panel with Ultritouch Device Interface Displayed

Figure 3  Ultritouch-4 — Front Panel with Ultritouch Device Interface Displayed

1. DB Button

Tap this button to display the Ultritouch Device interface, which is the main/Home menu. From 
this interface you access the following configuration features:

› General Info
› Manage Open Views
› Manage Custom Panels
› Connected Devices
› Network Settings
› License Management

Ultritouch
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Serial: 1234567890123
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Upload
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2. Connected Devices Button

Tap this button to display the All Connections interface in the Main Window. This interface 
reports the external devices that are communicating with the Ultritouch. Each device is 
represented as an individual button that when tapped displays the DashBoard menu system in 
the Main Window. Devices are added to the All Connections interface via the Ultritouch Device > 
Connected Devices interface.

3. File Navigator Button

Tap this button to display the File Navigator interface in the Main Window. Use this interface to 
select any custom panels uploaded into Ultritouch. 

4. Open Windows Button

Tap this button to reveal thumbnails of the currently open windows. Tapping a thumbnail opens 
that window full screen. This is useful for swapping between control panels for different devices.

5. Lock Button

Tap this button to lock the Ultritouch panel and display a spinner icon. You must tap and spin the 
icon to unlock the interface.

6. Home Window

The items in this window change depending on the function selected. This window can also 
display the currently loaded Ultrix soft panel or a custom panel for a DashBoard Connect 
compatible device.

7. Headphone Jack (Ultritouch-4RU only)

This is a 3.5mm headphone jack. When in use, the internal speaker of the Ultritouch panel is 
muted.

8. USB Port (Ultritouch-4RU only)

This is a standard USB 3.0 port. This port is not implemented.

Rear Panel Overview
The Ultritouch rear panel provides connections for power supplies, communications, and network 
connections. 

For More Information on...
• the power specifications, refer to Table 8.
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Figure 4  Ultritouch-2-HR — Rear Panel, Side View

Figure 5  Ultritouch-4 — Rear Panel, Side View

1. PWR1 and PWR2 Connections

There are two power supply connectors located on the rear of each Ultritouch. Each connector 
requires a 15VDC connection to an external power supply. 

Each Ultritouch ships with one power supply. An option is available to order a second power 
supply for redundancy.

Notice — The Ultritouch automatically powers on when power is applied.
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2. HDMI Port

This port is not implemented.

3. USB Port

This port is not implemented.

4. ENET1 and ENET2 Ports

Each ENET port is an RJ45 connector used to connect the Ultritouch to an external Ethernet 
network. 

Use the to bridge the external Ethernet network to the local communications bus for monitoring 
and control of the Ultritouch. 

 The ENET 2 port is not implemented.

Notice — The Ethernet ports do not provide, nor make use of, Power-over-Ethernet (PoE).
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Physical Installation
If you have questions pertaining to the installation of Ultritouch, contact us at the numbers listed in  
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Before You Begin
These installation guidelines assume the following:

• The relevant Ross equipment is installed into a ventilated rack frame. The relative humidity in the 
environment of the equipment should be <70% (non-condensing). The ambient temperature of 
the air entering the front panel should not exceed 40°C (104°F), and should not fall below 0°C 
(32°F).

• The install location of the panel should be accessible, dry, and dust-free.
• The socket/outlet should be installed near the equipment and be easily accessible.
• Valid IP addresses are assigned to the equipment by your IT Department.

Static Discharge

Throughout this chapter, please heed the following cautionary note: 

Mounting Requirements
Under some conditions, the ambient air temperature inside rack-mount cabinets can be greater 
than the ambient temperatures within a room. For safe long term reliability, ensure the ambient air 
temperatures of the panel are within the panel’s specified operating temperature range. Adequate 
ventilation within a rack frame must also be maintained.

For More Information on...
• the technical specifications for the Ultritouch, refer to “Technical Specifications”.

Rack Mounting the Ultritouch
The Ultritouch panel is designed for installation into a standard 19” equipment rack. It has 
integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

The Ultritouch panel mounts in the rack frame by means of four rack screws fastened through the 
front mounting ears. This should normally be sufficient to carry the load, including the weight of 
accompanying cables. 

For More Information on...
• rack mounting the Ultritouch, refer to the Ultritouch Quick Start Guide.

VESA Mounting the Ultritouch-4
The Ultritouch-4 can also be used in a VESA 100mm compliant (flat-back) mount where there are 
four holes at 100mm pitch in a square pattern on the center of a VESA mounting application. 
Installing the Ultritouch-4 to a VESA mount requires you to:

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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1. Remove the rack mount brackets from either side of the Ultritouch-4 panel. 

2. Install the U4-VESA100 plate to the Ultritouch-4 panel. 

3. Install the Ultritouch-4 and U4-VESA100 plate to your VESA mount.

Required Equipment
You will need:

• One Phillips #1 screwdriver
• One Phillips #2 screwdriver
• One Ultritouch-4 panel
• One U4-VESA100 Kit which includes one plate (P/N 2201FR-089), four #6-32 screws (P/N 

88-01087), and four M4 mounting screws (P/N 850-062R)

Removing the Rack Mount Brackets from the Ultritouch-4
The Ultritouch-4 comes standard with rack mount brackets affixed to each side of the panel via six 
screws per bracket. Each rack mount bracket includes a front mounting ear and an end bracket. 
When installing the Ultritouch-4 in a VESA mount application, you must first remove each rack 
mount bracket from the Ultritouch-4 panel, separate the front mounting ear from the end bracket, 
and then re-install the end bracket back onto the panel. 

To remove the rack mount brackets from the Ultritouch-4 panel

1. Set the Ultritouch-4 on a flat, clean, and static-free surface with the display facing away from 
you. 

2. On the left-side of the Ultritouch-4, locate the six screws that affix the rack mount bracket to the 
panel.

3. Use a Phillips #1 screwdriver to remove the screws. Set the screws aside.

 You will need these screws to re-install the end bracket onto the Ultritouch-4 panel.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.



Ultritouch User Guide (v3.0) Physical Installation • 21

Figure 6  Removing the Left Rack Mount Bracket from the Ultritouch-4 Panel

4. Pull the rack mount bracket away from the Ultritouch-4.

5. Separate the front mounting ear from the end bracket. Set the front mounting ear aside.

6. Re-install the end bracket onto the left-side of the panel using the screws from step 3.

Figure 7  Re-installing the Left End Bracket on the Ultritouch-4 Panel

7. Repeat steps 2 to 6 for the rack mount bracket on the right-side of the panel.

Installing the U4-VESA100 to the Ultritouch-4
The U4-VESA100 plate includes four pairs of opposing holes and four #6-32 screws. You must 
position the plate over the four VESA Adapter Plate holes on the Ultritouch-4 panel, then attach the 
plate using the provided screws.

To install the U4-VESA100 to the Ultritouch-4

1. Determine where and how the Ultritouch-4 will be affixed to the VESA mount. Ensure:

• the Ultritouch-4 will not interfere or block any ports, connectors, or other features of nearby 
equipment;

End Bracket

Front
Mounting Ear
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• access to the Ultritouch-4 connections is available once it is installed on the VESA mount.

2. Set the Ultritouch-4 on a flat, clean, and static-free surface with the display facing down. 

3. Locate the four VESA Adapter Plate holes (outlined with white circles) on the rear of the 
Ultritouch-4 panel.

4. Position the U4-VESA100 plate over the four holes.

5. Use a Phillips #2 screwdriver and the provided screws to fasten the plate to the panel. (Figure 8)

Figure 8  U4-VESA100 Bracket on the Ultritouch-4 Panel

Installing the Ultritouch-4 to a VESA Mount
The U4-VESA100 is designed to be used in a VESA 100mm compliant (flat-back) mount where there 
are four holes at 100mm pitch in a square pattern. You will need to use these four holes to affix the 
Ultritouch-4, via its U4-VESA100 plate and the provided four M4 mounting screws, to the VESA 
mount.

 The four M4 mounting screws assume your VESA mount has a material thickness of ~2mm 
(0.08”).

To install the Ultritouch-4 to a VESA 100mm mount

1. Install the VESA 100mm mount as outlined in its documentation.

2. Position the Ultritouch-4 over the VESA mount, ensuring the U4-VESA100 plate aligns over the 
screw holes of your VESA 100mm mount.

3. Secure the Ultritouch-4 to the VESA mount using the provided four M4 mounting screws.

 Ensure your mounting screws accommodate the Ultritouch-4 U4-VESA100 plate yet still engage 
with the mount. 

4. Secure the Ultritouch-4 power supply.

U4-VESA100 Plate
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Cabling
This chapter outlines how to establish a physical connection between the Ultritouch panel and your 
facility network, and then to a power supply.

Connecting the Ultritouch to a Network
The ENET 1 port is a standard 10/100/1000 RJ45 Ethernet connector and is used to exchange data 
and communicate with other devices in your router system. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

The Ultritouch is connected directly to your network so that it can interface with the devices in your 
routing system. After a physical connection is established, use the DashBoard client running on 
your Ultritouch to configure the network settings for the Ultritouch.

 Contact your network administrator if difficulties or problems are experienced when connecting 
the Ultritouch to a network hub, or with assigning IP addresses.

To establish a physical connection to the network

1. Connect one free end of the straight through CAT5/5e/6 cable to a free port of the network hub.

2. Connect the other end of the same cable to ENET 1 on the Ultritouch rear panel.

Figure 9  Ultritouch-2-HR — ENET 1 Connection

To network hub
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Figure 10  Ultritouch-4 — ENET 1 Connection

Connecting to a Power Supply
The Ultritouch panel is powered by one +15V DC, 30W PSU, with an optional PSU available to 
provide redundancy and load sharing.

For redundancy, each power cord should be connected to a separate power source for protection 
against failure of the A/C power circuit. In the event of one power supply failure, the panel load is 
seamlessly transferred to the other connected redundant power supply.     

Warning Hazardous Voltages — The safe operation of this product requires that a protective 
earth connection be provided. This protective earth is provided by the ground conductor in the 
equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this 
ground connector must be connected to an earthed ground.

Warning — In some countries it may be necessary to supply the correct mains supply cord. Use only 
certified cords for the country of use.

To network hub



Ultritouch User Guide (v3.0) Cabling • 25

To connect the power cables to the Ultritouch panel

1. Connect the male end of the provided power cable into the socket marked PWR1 on the 
Ultritouch rear panel.

Figure 11  Ultritouch-2-HR — Primary Power Connection 

Figure 12  Ultritouch-4 — Primary Power Connection 

2. Connect the remaining power cable into the PWR2 power supply socket if redundancy is 
required.

3. Connect the supplied AC power cable into the power modules.

4. Connect the supplied power cable’s three-prong male connector to an AC outlet.

Notice — The Ultritouch automatically powers on when power is applied.

Note: It is recommended that 
you always connect the Power 
Supply Unit to the Ultritouch-2 
before connecting to Mains 
Power.

Note: It is recommended 
that you always connect 
the Power Supply Unit to 
the Ultritouch-4 before 
connecting to Mains 
Power.



26 • Cabling Ultritouch User Guide (v3.0)



Ultritouch User Guide (v3.0) Configuring the Network Settings • 27

Configuring the Network 
Settings
The Ultritouch system comes pre-configured with default settings that you may wish to configure as 
per your facility requirements. This chapter outlines how to assign a static IP Address to the 
Ultritouch panel, and navigate the menu system of the touch-screen panel.

Overview
Updating the network settings is the first task to accomplish once the physical installation is 
completed. There are two methods outlined in this chapter:

• Walkabout — use the Walkabout application, running on a DashBoard client computer in your 
network.

• Ultritouch — use the touchscreen of the Ultritouch hard panel.

Using Walkabout to Assign the Ultritouch IP Address
Once the Ultritouch panel is physically installed and cabled to your facility network, you will need to 
assign it a static IP Address to enable DashBoard (running on a computer connected to the same 
subnet) to locate it on your network. Establishing a static IP Address enables the DashBoard client 
running on Ultritouch to detect other DashBoard Connect compatible devices on the same subnet.

To assign a static IP address to the Ultritouch panel
1. Launch a DashBoard client from a computer connected to the same IP address subnet as the 

Ultritouch.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
table is current.

4. In the Walkabout table, find the entry for the Ultritouch you want to configure.

 It may be identified in the table via the default IP Address of 192.168.20.160.

5. Use the Name field to assign a unique identifier to the Ultritouch panel. This will be the name 
displayed in the Tree View of DashBoard.

 After you edit a cell in the Walkabout table, the Connection/Link Quality value for the device 
reports 1%. It is recommended to wait approximately 1 minute, then click Refresh to apply the 
new settings.

6. Use the Address field to specify the IP Address supplied by your IT Department for this device.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultritouch.
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Adding the Ultritouch to the Tree View in DashBoard
Once you have assigned the Ultritouch a static IP Address, you can then manually add it to the Tree 
View. Manually Adding the Ultritouch displays its node in the Tree View in the DashBoard client 
software on your computer, granting you access to the interfaces described in “Menu System 
Overview”.

To manually add the Ultritouch to the Tree View in DashBoard
1. In the Basic Tree View toolbar of DashBoard, click .

The Select Equipment or Service Type to Add dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Select the JSON radio button as the Protocol.

6. Enter the IP Address for the panel in the IP Address field that you assigned in the section “To 
assign a static IP address to the Ultritouch panel”.

7. In the text fields provided, enter the display name and the port of the panel you wish to add.

8. Click Finish. 

The Ultritouch displays in the Tree View. 
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Updating the Network Settings for the Ultritouch via the Hard 
Panel
You may wish to change the Ultritouch network settings from the default values but do not have 
access to a computer running the Walkabout application. The touch-screen menu system enables 
you to change the IP Address and update other network settings.

There are two methods to assign an IP address to the Ultritouch: manually assigning the settings or 
enabling the DHCP server in your network to assign the settings to the panel. Both methods are 
described below.

To manually assign the network settings to the Ultritouch

1. Tap .

 You will need to scroll through the menu list displayed under the Ross logo.

2. Tap Network Settings.

3. In the DHCP area, tap Off.

4. Use the IP field to assign a static IP Address to the Ultritouch.

5. Use the Subnet field to specify the subnet mask for your network.

6. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN) that the Ultritouch will use.

7. Tap Apply.

To automatically obtain the network settings for the Ultritouch

1. Tap .

 You will need to scroll through the menu list displayed under the Ross logo.

2. Tap Network Settings.

3. In the DHCP area, tap On.

4. Tap Apply.

Re-naming the Ultritouch
Each Ultritouch can be given a unique name that is used on internal menus and as the identifier in 
the routing system. 

To re-name the Ultritouch

1. Tap .

2. Tap General Info.

3. Select the Device Name field.

4. Type a new name for the Ultritouch in the Device Name field.

5. Tap Apply.
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Basic Navigation
There are two methods for accessing the Ultritouch menu system: via a DashBoard client running 
on a computer connected to the same subnet as the Ultritouch, or via the touchscreen of the hard 
panel. This chapter outlines both methods.

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

For More Information on...
• the menus and options in each interface, refer to “Menu System Overview”.

Using the Touchscreen
The Ultritouch touchscreen menu system is organized into four interfaces: Ultritouch Device, All 
Connections, File Navigator, and Open Windows. Each interface is represented as a button on the 
left toolbar of the panel. Tap a button to display that interface on the touchscreen. Figure 13 
illustrates the user selecting the Network Settings button on the Ultritouch Device interface.

Figure 13  Example of Navigating the Ultritouch Touchscreen

Use this method of navigating the menu system to access:

• multiple device views
• custom panels
• Ultrix soft panels

Navigating the Ultritouch Menus via the Touchscreen
The interfaces are accessed by tapping buttons on the main toolbar of the Ultritouch panel. 

To access the Ultritouch Device interface via the touchscreen

1. Tap .

2. To access additional menus:

a. Scroll through the menus using the arrows.

b. Tap a button to displays its interface.

Ultritouch
IP:

Mask:

Gateway:

DNS (Primary):

DNS (Secondary):

12.32.123.235

555.555.555.5

12.65.123.2

10.1.0.03

10.2.0.05

Connected Devices

Network Settings

Device Options

ON

DHCP

OFF

CANCEL APPLY
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 Note that the button you tap now displays a blue bar on its right side. 

To access the All Connections interface

• Tap .

To access the File Navigator interface

• Tap .

To access the Open Windows interface

• Tap .

 A maximum of 4 windows can be opened at one time. When the limit is reached, the panel with 
the earliest timestamp is automatically closed.

Using a DashBoard Client Computer

The Ultritouch displays as a device node in the Basic Tree View in the window of your DashBoard 
client. Much like other DashBoard Connect devices, you access the interfaces and menus of 
Ultritouch by first selecting its node in the Basic Tree View to display the device view of the panel in 
the DashBoard window.

When using a DashBoard client computer to access the Ultritouch, the interfaces are organized into 
a series of buttons at the bottom of the window. By default, the General Info interface displays as 
the homepage.

Use this method of navigating the menu system to:

• load device views
• load custom panels

Figure 14 illustrates an Ultritouch displayed in the DashBoard client window after the user selected 
the Network Settings button.
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Figure 14  Example of Navigating the Ultritouch Menus via the DashBoard Tree View

Navigating the Ultritouch Menus via a DashBoard Client Computer
 The DashBoard client computer must be connected to the same subnet as your Ultritouch panel.

To access the Ultritouch Device interface via a DashBoard client computer
1. Launch DashBoard by double-clicking its icon on your computer desktop.

2. Ensure the DashBoard client computer is running DashBoard software version 8.5.0 or higher.

 This information is available by selecting Help > About DashBoard from the main toolbar.

3. Locate the Ultritouch in the Tree View of DashBoard.

4. Expand the Ultritouch node to display the Ultritouch Device sub-node.

5. Double-click the Ultritouch Device sub-node.

The Ultritouch Device interface displays in the right-side of the DashBoard window with a 
bottom toolbar that includes selectable buttons.
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Communications with Devices
This chapter provides a general procedure for creating a connection point between the Ultritouch 
and external devices in your routing system. The specific steps for your devices may differ than 
what is presented here. 

 The procedures in this chapter assume you are navigating the Ultritouch menus via the hard 
panel. 

For More Information on...
• the menu system, refer to “Menu System Overview”.
• creating a connection point between the Ultritouch and your device, refer to the user 

documentation for your device.

Before You Begin
The Connected Devices interface lists external devices that the Ultritouch detects and can connect 
to, and provides status information. You can also disconnect communications between a device 
from Ultritouch. There are two methods for adding an external device to the Ultritouch: using the 
auto connect feature or manually adding a device by specifying the IP address of the device. Both 
methods are described in this chapter.

 You can also drag and drop devices nodes from the Basic Tree View to the Ultritouch Connected 
Devices tab in a DashBoard client. Refer to the Ultritouch Quick Start Guide for details.

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

Automating Connections
There are two features that you can use to auto detect and connect to external devices in your 
routing system.

Using the Auto Detect Feature
By default the Ultritouch auto detects any external device on the same IP subnet. Ultritouch queries 
the network for new devices approximately every 10 seconds if the Automatic Detection feature is 
enabled.

To enable the Ultritouch to auto detect external devices in your routing system

1. Tap .

2. Tap Connected Devices.

3. Tap Enable Auto Detect.



36 • Communications with Devices Ultritouch User Guide (v3.0)

Using the Auto Connect Feature
The auto connect feature is independent from the auto detect feature. This allows you to still 
manually select what devices to connect to. Once the auto connect feature is enabled, Ultritouch 
will automatically create a connection point to devices listed in the Connected Devices table.

To enable the Ultritouch to auto connect to external devices in your routing system

1. Tap .

2. Tap Connected Devices.

3. Tap Enable Auto Connect.

Manually Connecting to an External Device
You must manually create a connection point to an external device when the device is on a different 
subnet from your Ultritouch. 

If the Auto Detect or Auto Connect options are disabled, you can still create a connection point to an 
external device by manually specifying their IP address in the Ultritouch Device interface.

To manually add a connection point to an external device

1. Tap .

2. Tap Connected Devices.

3. Tap Add.

4. Tap Manually Add a Connection Point.

5. Use the Device IP/Hostname field to specify the IP Address for the external device.

6. Tap Add Device.

The device is now listed in the Connected Devices table.

7. Select the device from the Connected Devices table.

8. Tap Connect.

OGP and JSON Connections
This section outlines how to establish a connection point when your device communicates over TCP 
via the openGear protocol (OGP) or the JavaScript Object Notation (JSON).

To manually add a connection point to an external device via OGP or JSON protocol

1. Tap .

2. Tap Connected Devices.

3. Tap Add.

4. Tap TCP/IP DashBoard Connect/openGear Device.

5. Use the Device IP/Hostname field to specify the IP Address for the external device.

6. Use the Device Name field to specify the device name (as you want it to appear in the 
Ultritouch interfaces).
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7. Use the Protocol menu to specify whether the device communication language. 

8. Use the Port field to specify the port on the device used for communicating with the Ultritouch.

9. Select the Remember connection settings for this device to retain the settings after a loss of 
communication.

10. Tap Add Device. 

11. Select the device from the Connected Devices table.

12. Tap Connect.
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File Management
This chapter outlines how to use the File Navigator interface to load your custom panel and device 
files to the Ultritouch. 

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

 A connection must be established between Ultritouch and the device that you are uploading the 
file to. Refer to “Communications with Devices” for details.

Loading Custom Panels
The File Navigator interface enables you to quickly navigate to device custom panels. A custom 
panel is a user interface created using the PanelBuilder™ tool in DashBoard. Custom panels can 
include any combination of PanelBuilder objects, panel components, and parameters. Custom 
panels enable you to create interfaces for your DashBoard Connect devices, then load the panel file 
to the Ultritouch for operating and monitoring that device.

For More Information on...
• using PanelBuilder, refer to the DashBoard User Guide.

Before You Begin
PanelBuilder provides a template for creating and editing a custom panel for use on an Ultritouch 
hard panel. This template is a canvas layout of 1304x203 pixels to match the hard panel display 
area. You must create a custom panel using PanelBuilder on your DashBoard client computer 
before you can upload and use it on Ultritouch.

Figure 15  Ultritouch — Example of a Loaded Custom Panel

For More Information on...
• creating and editing custom panels for Ultritouch, refer to the DashBoard User Guide.
• creating a soft panel for Ultrix, refer to the Ultritouch+Ultrix User Guide.

Uploading a Custom Panel File to the Ultritouch Directory
Once you have created your Ultritouch custom panel in PanelBuilder, you can open and load the file 
to an Ultritouch hard panel. You can upload multiple custom panels to the Ultritouch system, but 
the hard panel can only display one custom panel at a time.

 Before proceeding, ensure you have established communications between the Ultritouch and the 
device the custom panel was designed for.

To upload a custom panel file to the Ultritouch
1. Navigate to the Ultritouch Device interface using the method described in “To access the 

Ultritouch Device interface via a DashBoard client computer”.

2. Click Manage Custom Panels.

The Custom Panels interface displays in the DashBoard window.
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3. Click Upload to Folder.

The Upload File dialog opens.

4. Select the custom panel file to load.

 Uploaded *.zip files (custom panels with image assets etc.) are automatically unzipped into a 
directory named the same as the original *.zip file.

Using Custom Panels
To operate a custom Panel, use the File Navigator to browse the Custom Panels directory. The File 
Navigator interface displays and uploaded custom panels in a hierarchy. This hierarchy is 
determined by the timestamp of the loaded files.

To open a custom panel
1. On the Ultritouch hard panel, tap .

2. Navigate to the file you wish to open.

3. Tap Open File.

To remove a device file from the File Navigator interface
1. On the Ultritouch hard panel, tap .

2. Navigate to the file you wish to remove.

3. Tap the file to reveal the available operations.

4. Tap Remove.
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Managing Open Windows
Ultritouch tracks the DashBoard Connect devices that you frequently access and arranges their 
“view” in a single window for ease of use.

 This chapter uses the Ultritouch-2-HR in its examples, but the information also applies to the 
Ultritouch-4.

To specify a new device view

1. Tap .

2. Tap Manage Open Views.

3. Perform one of the following:

•  — Tap this button to display the Devices Navigation interface.

•  — Tap this button to display the Files Navigation interface.

The interface updates to show a list of external devices made available using the procedures in 
“Communications with Devices”.

4. Tap the device you wish to view.

5. Tap Open Selected.

To specify a new file view

1. Tap .

2. Tap Manage Open Views.

3. Tap Files.

The interface updates to show a list of devices files made available using the procedures in 
“Using File Navigator”.

4. Tap the entry for the file you wish to view.

5. Tap Open Selected.

To view a new device interface on the Ultritouch
1. Tap .

2. Tap the entry for the device you wish to access.
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To close a device interface from the Ultritouch
1. Tap .

2. Tap the X next to the device name you wish to close.
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Menu System Overview
There are two methods for accessing the interfaces: a DashBoard client computer or using the 
Ultritouch hard panel. This chapter outlines the menus available using both methods but uses the 
menus from the hard panel in the provided examples.

 This chapter uses the Ultritouch-2-HR in most of the examples, but the information also applies 
to the Ultritouch-4 unless otherwise noted.

Ultritouch Device Interface
Use this interface to change the network settings for the panel, establish communications with 
devices in your routing system, manage your custom panels, and download system logs for 
troubleshooting.

General Info
By default, the General Info window is automatically displayed when the Ultritouch Device interface 
is loaded.

 To access this interface on a DashBoard client computer, double-click the Ultritouch Device 
sub-node in the Tree View.

Figure 16  Example of the General Info Window on an Ultritouch-2-HR Panel

Table 1 summarizes the read-only fields displayed in the General Info window. 
Table 1  General Info

Item Parameters Description
Device Name <text> Identifier assigned to this panel during the 

installation and setup

Device ID # An unique number assigned to the hard 
panel to help identify it within your system

Type <text> Defines the model of Ultritouch panel

Serial # Indicates the serial number of the 
Ultritouch panel

DashBoard Version # Indicates the DashBoard client version 
running on the Ultritouch panel

Firmware Version # Indicates the build version of the Ultritouch 
panel

Download Logs *.txt Enables you to capture the communication 
activity of the panel into a text file

Upload Enables you to update the DashBoard 
software running on your Ultritouch
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Manage Open Views
The Open Views interface display a list of custom panels and/or device files that were previously 
loaded to the Ultritouch panel. To access this interface, tap Manage Open Views. 

Figure 17  Example of the Manage Open Views Window

Table 2 summarizes the fields displayed in the Manage Open Views window.

Manage Custom Panels
Use the Manage Custom Panels interface to load a custom panel file to the Ultritouch panel.

 You cannot edit a custom panel using this interface. Use the PanelBuilder™ feature in a 
DashBoard client to create and edit custom panels for the Ultritouch. Refer to the DashBoard 
User Guide for details.

Figure 18  Example of the Manage Custom Panels Window

Connected Devices
The Connected Devices interface provides information on the external devices currently 
communicating with the Ultritouch panel. From this interface you can manage which devices the 
Ultritouch can access. 

Figure 19  Example of the Connected Devices Window

Table 2  Manage Open Views

Item Description
Devices Tap this button to display a hierarchical list of 

external devices that have established 
communications with this Ultritouch

Files Tap this icon to display a list of files recently 
accessed by Ultritouch

Show Navigation Tap this button to display the navigation tree for

Open Selected Tap this button to load the interface for the selected 
device
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Table 3 summarizes the fields displayed in the Connected Devices window.

Network Settings
The Network Settings window enables you to edit and verify the IP Address and other settings 
according to your facility network requirements.

Figure 20  Example of the Network Settings Window

Table 4 summarizes the fields displayed in the Network Settings window.

Table 3  Connected Devices

Item Description
Device Name Reports the name assigned to the external device

Status Duplicates the status reported by the device. Refer to 
the user guide for the device to learn more about the 
possible messages.

Add Use this button to manually add a new device to the list 
of Connected Devices

Remove Use this button to manually remove a device from the 
list of Connected Devices

Enable Auto Detect Enables Ultritouch to auto-detect any DashBoard 
Connect compatible devices on the same IP subnet and 
add the device to the Connected Devices table

Enable Auto 
Connect

Enables Ultritouch to automatically connect to 
DashBoard Connect compatible devices and add them 
to the Connected Devices table

Connect Enables communication between the selected device 
and Ultritouch

Disconnect Disables communication between the selected device 
and Ultritouch

Table 4  Network Settings

Item Parameters Description
IP ###.###.###.### Specifies the IP address for the Ultritouch 

panel

Mask ###.###.###.### Specifies the subnet mask for the Ultritouch 
panel

Gateway ###.###.###.### Specifies the gateway for communication 
outside of the local area network (LAN)

DNS (Primary) ###.###.###.### Specifies the Primary Domain Name Server 
for your network
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Device Options
The Device Options window enables you to adjust the display brightness and speaker volume, 
calibrate the hard panel settings back to their default settings, and initiate a reboot of the panel.

All Connections
The All Connections interface provides access to the menu system and operational features of 
DashBoard Connect compatible devices. Only devices added via the Connected Devices interface, 
with established connections to Ultritouch, are accessible in this interface.

Tap  on the hard panel to display the All Connections interface. (Figure 21) 

Figure 21  Example of the All Connections Interface

For More Information on...
• the menu system for your DashBoard Connect compatible device, refer to its user guide.

File Navigator Interface
The File Navigator interface in Ultritouch enables you to quickly navigate to any installed Custom 
Panel file. Custom Panels are created using the PanelBuilder tool in the DashBoard client software.

Tap  on the hard panel to display the File Navigator interface. (Figure 22)

Figure 22  Example of the File Navigator Interface

Open Windows Interface
The Open Windows interface in Ultritouch reports which device interfaces were recently accessed 
by the Ultritouch. Each device is represented by a pane in the interface which includes a thumbnail 
of the last menu/tab that was accessed and a status bar. Select a pane to display that device on the 

DNS (Secondary) ###.###.###.### Specifies the Secondary Domain Name 
Server for your network

DHCP Off The user manually supplies the network 
settings for the Ultritouch panel

On Automates the assignment of network 
settings for the Ultritouch panel

Table 4  Network Settings

Item Parameters Description
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Ultritouch, or scroll through the panes to quickly monitor the devices communicating with 
Ultritouch.

Tap  on the hard panel to display the Open Windows interface. (Figure 23)

Figure 23  Example of the Open Windows Interface

Lock the Ultritouch Interface
You can choose to lock the hard panel so that all menus and parameters cannot be accessed.

Tap  on the hard panel to lock the panel. (Figure 24)

Figure 24  Example of a Locked Panel
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Technical Specifications
This chapter provides technical information for Ultritouch. Note that specifications are subject to 
change without notice.

Physical Dimensions

Ethernet Port Connectors
Each Ultritouch comes standard with two Ethernet ports on the rear panel to interface with a local 
network, and Ross devices that use an Ethernet protocol for communications. The Ethernet ports 
are operated in a link aggregated or bonded configuration to provide failover functionality.

 The ENET 2 port is not implemented.

Environmental

Table 5  Technical Specifications — Physical Dimensions

Item Specification
Ultritouch-2-HR

Width 19” (48cm)

Depth 2.5” (6cm)

Height 3.5” (9cm)

Weight (approx.) 5.25lb (2.40kg)

Ultritouch-4

Width 19” (48cm)

Depth 2.6” (6.5cm)

Height 7.0” (18cm)

Weight (approx.) 12.0lb (5.40kg)

Table 6  Technical Specifications — Ethernet Ports

Item Specifications
Number of Ports 1

Connector Type 8-pin, RJ45 

Table 7  Technical Specifications — Environmental

Item Specifications
Maximum Ambient 
Temperature Range

0°C to 40°C (32°F to 104°F)

Humidity, non-condensing < 95%
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Power
Table 8  Technical Specifications — Power Supply Ratings

Item Specifications
Ultritouch-2-HR

Number of Ports 2

Power 15VDC @ 4A

Input 100-240Vac, 50/60Hz

Input Current 1.4A

Ultritouch-4

Number of Ports 2

Power 15VDC @ 4A

Input 100-240Vac, 50/60Hz

Input Current 1.4A
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between Ultritouch and a 
device in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a signal output from the routing system.

Hard Panel — the physical Ultritouch panel that provides a touchscreen interface to the menu 
system.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Soft Panel — a DashBoard software interface that represents a panel of buttons that is used to 
control the routing system.

Source — a signal input to the routing system.

Ultritouch — refers to the Ultritouch-2-HR and Ultritouch-4 unless otherwise noted.

Ultritouch-2 — refers to an Ultritouch 2RU with a resolution of 1440 x 230.

Ultritouch-2-HR— refers to an Ultritouch 2RU with a resolution of 1920 x 285.

Virtual Label — a name for a group of routing system inputs or outputs.

Virtual Routing — the action of switching a group of otherwise unrelated signals via a common 
label (name).
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